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BASICS OF COMPUTER

Introduction

In this lesson the basic structure of the computer system, its parts, functions and types of software are
studied. Computer hardware and software work together. In this chapter the structure of computer, input-

output devices, memory, software and computer languages have been described.

What is a Computer?

e A computer is a device that transforms data into meaningful information.
e It can accept, store, process and retrieve data.

e Main characteristics — high speed, accuracy, storage capacity, versatility.
Five basic functions of a computer:

e Input - entering data/instructions

e Storage (Memory) - storing data

e Processing — processing the data

e Output - displaying the result

e Control - control of all operations

m Memory Unit

) 1

e Input Unit - accepts data putunt | | uputen
i
e Control Unit (CU) - controls all operations fg;':mm

e Memory Unit - stores data

e Arithmetic Logic Unit (ALU) - addition, subtraction, multiplication, division,
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e Output Unit - presents the result

e CPU (Central Processing Unit) = ALU + CU

Peripheral Devices|

e Input devices
e Output devices

e Other peripheral devices

e Keyboard
e Mouse
e Light Pen

e Optical Scanner

e Touch Screen

e Microphone

e Track Ball

e The most common input device

e QWERTY keyboard is more popular

e Generally 104 keys
e Hand-operated device
e Point and Click action

e Menu selection, icon transfer
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e Light sensitive device

e For selecting objects on the screen
Optical Scanne

e Converts image into electronic form
o OCR (Optical Character Recognition) — converting scanned image into text
e Giving input by touching the screen
o Alternative to keyboard

e Sound input device

e Two types — Desktop, Hand held
Track Ball

e Device like an inverted mouse

e Useful in less space

Output Devices| T |

e Monitor

e Printer

e Plotter

e Speaker

Monitor e |

e Main output device
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Types:
o CRT (Cathode Ray Tube)

o LCD (Liquid Crystal Display)

e Resolution — 800x600, 1024x768 etc.

Types:

Laser Printer — high quality, fast

Inkjet Printer — printing through ink

Dot Matrix Printer — low quality, more noise

Line Printer - high speed, used in large computers
e For making large pictures/designs
o Types:

o Flat Bed Plotter

o Drum Plotter

Sound output device
Two types:

o Primary Memory - RAM

o Secondary Memory - CD-ROM, Pen Drive
e Primary memory is fast

o Data is lost when the computer is switched off
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e A group of instructions
e Gives instructions to hardware to perform work

Classification:

o System Software

o Application Software

o For operating the computer

e Example: Operating System (OS)
e Popular OS - Windows, Unix, Linux
Utilities

e Antivirus

e File Compression

e File Management

For specific tasks

e Generalized Package

o Word Processing

o Spreadsheet

o Presentation

o Database
ﬁ All Rights Reserved © Manish Verma (MVS Foundation), for more Notes visit https://www.mvsfoundation.in/ 8
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o Customized Package
o Payroll
o Inventory Control
o Student Information System

Computer Languages

1- Low Level Languages

« Machine Language - based on 0 and 1 100110700700000010170

01010010010010010100

o Assembly Language - use of mnemonics

2- High Level Language
e Easy to understand
e Not machine dependent

Examples:

BASIC: A simple and beginner level high level programming language, which is easy to learn.

COBOL: A high level language developed for commercial and business applications.

FORTRAN: A programming language developed for scientific and mathematical calculations.

e C: A structured programming language, which is used in making system and application software.
e C++ : An object oriented programming language, which is an advanced form of C language.

o Compiler - converts high level language into machine language

e Assembler - converts assembly language into machine language

e Source Program — Object Program
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https://www.mvsfoundation.in/

{ MY/s FOUNDATION | (' DATA ENTRY OPERATIONS (336) )

BY MANISH VERMA -

TOP 5 QUESTIONS

Q-1. Write the five basic functions of a computer.

Answer- The five basic functions of a computer are — input, storage, processing, output and control. All

these functions together make the computer fully capable of working.
Q-2. What is CPU?

Answer- CPU stands for Central Processing Unit. It includes ALU and CU. It is the brain of the computer

that performs all calculations and control functions.
Q-3. Write the difference between system software and application software.

Answer- System software performs the task of running and controlling the computer, such as operating

system. Application software is made for specific tasks, such as word processing or spreadsheet.
Q-4. Tell the difference between high level and low level language.

Answer- Low level language is based on machine and is difficult to understand. High level language is

simple, user friendly and not machine dependent.
Q-5. Write the types of printer.

Answer- The main types of printer are — Laser Printer, Inkjet Printer, Dot Matrix Printer and Line Printer.

Their speed, quality and usage are different.
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FORMATTING DOCUMENTS

Introduction

In this chapter typing text in a document, editing, formatting, copying-cutting and doing page setting

have been taught. With the help of Word 2007, text can be made attractive and well-organized.

Working With Text

e The text is displayed where the cursor is located. .y

e When the line is completed, the text automatically moves to the next line.

I

o Press Enter to create a new paragraph.

Inserting Text

e Change the cursor position using Arrow Keys or Mouse.

o Shortcuts:

o Home - beginning of the line

o End-end of the line

o Ctrl+Home — beginning of the document

o Ctrl+End — end of the document

Spacebar and Tabs

e Use Spacebar for distance between words.

e Use Tab Key to create columns.

e Do not use extra spaces.

@ All Rights Reserved © Manish Verma (MVS Foundation), for more Notes visit https://www.mvsfoundation.in/ 11
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Paragraph Markers ()

e The T symbol shows returns, spaces, tabs.

e Show or hide using the Show/Hide button.

Word — Double Click

On the Insert tab, the galleries incude items that are designed to coordinate with the overall look of
your document. You can use these galleries to insert tables, headers, footers, lists, cover pages, and

) Pa ra g ra p h — Tr| p I e C I | C k B other document building blocks, When you create pictures, charts, or diagrams, they also coordinate

with your current document look.

You can easily change the formatting of selected text in the document text by choosinga look for the
salected toxt from the Quick Styles gallery on the Home tab, You can also format text directly by

o Entire document — Ctrl + A t e g A ey, SRS
Deleting Text S p—
o Backspace - deletes the text to the left.

o Delete - deletes the text to the right.

Replacing Text]

e Select the text — type new text.

e The old text will be replaced automatically.

Click and Type

Text can be inserted by double clicking anywhere on the page.
Formatting Text

Main options:

Numbered and Increase/
e Font Face - type of letters — bulleted lists Decrease
L . |
o Font Size - size of letters (in Points) T —— T < [
w Rom 2 A A= 3
B Z U ~abe x, X Aav||¥~ A-||| ==
« Bold, Italic, Underline - letter style 1 |
. . . Bold, Italics and Left, center,
e Alignment — Left, Center, Right, Justify Underline right
justification
¢ Indent Increase/Decrease
o Highlight Color
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e Font Color

Format Painter

e Applies the formatting of one text to another.
Formatting Paragraphs

e A new paragraph is created by pressing Enter.

e Paragraph format applies to the entire paragraph.
Line Marker

e Shift + Enter — new line, but not a new paragraph.
Text can be aligned Left, Center, Right or Justify.
Indenting Text|

e Indent the paragraph using Indent Marker.

e Hanging Indent - indent all lines except the first line.

1. Default Tab — 0.5 inch

Types:

o LeftTab - - 1
k

e Center Tab
T.eﬁl tab

e Right Tab Apples
Oranges
Peaches

e Decimal Tab
Line Spacing
e Single

e 1.5 Line

(:' DATA ENTRY OPERATIONS (336) )

(@) E[9-6E 15 FEp-

L[] =
\—/| Home | Insert Page Layout References

I
= 3
1 &t Times Mew Roman b P |
P‘ N 152 Copy - ]
aste - z -
- ;fFUrmat Painter |B Zujpu! - .abe .X, .X _Aa |

Clipboagiy, E] Font

f |

'l Tk
& 4 h
Center tab Right tab [Jemzt1al-.tnh
4l $1.20/1b $4.80
101y $1.40/ S14.0
100 1k $1.50/1b. $150.00
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e Double

o Before and After spacing can be set.

e When a paragraph is deleted, extra blank line does not remain.
Borders and Shading

e Border can be applied around the paragraph.

e Shading can be applied in the background.

Bulleted And Numbered Lists|

Creating a Bulleted and Numbered List

Choose Bullets or Numbering from Formatting Toolbar.

e On pressing Enter, the next bullet is created automatically.

Document? - Microsoft Waord

Wi 9-0&l=-
| Hame | Insert Page Layout

References Mailings Reviaw

View

(:' DATA ENTRY OPERATIONS (336) )

Review View Add-Ins

AaBbCcDe|| AaBb(
T Mormal

Oy~ i
1.0

T Mo Sp

115

-

1.5
V| 20
25
3.0
Line Spacing Options..

=l i<

%idd Space Before Paragraph

emove Space After Paragraph

= | B |

o @ o @ =

& |5fE (Body Asian] -|lEE -]

By | B 7 U -abe x, x* | &}
Paste . -
- F AW Ardar | AT LA
Clipboard Font ra

A A=

Quick Change | Editing
Styles = Styles = - ‘

Buflet

Styles Ta
42

@_R 2 4 1 5 10 12 14 15 15 20 22 24
| T T T T T T T T T T T T

34 35 3 Jw

e

[+

A sub-list is created by Increase Indent.

Formatting Bulleted and Numbered Lists

e The bullet symbol can be changed.

e The Number Style can be changed.
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Copying Text And Moving (Cutting) Text

Use of Clipboard

Copied or Cut text is stored in the Clipboard.

e It can be reused by Paste.

Ctrl + X — Ctrl + V [mﬂ + ‘C

Copying Text Ctrl s \Vi

Ctrl + C—> Ctrl + V

Spelling And Gramma

Red line under incorrect word. M EH v J = Document2

Insert Design Layout References Mailing

Green line under grammar error.

Press F7 to check.

Asjdkhasjkdh sddfkjhad kldhjasdh asjkdhaskjdh a

Ignore, Change, Add options available.

Page Formatting

Page Design from Page Layout Tab.

Page Margin

Can be changed using Ruler.

Can be set using Page Setup Dialog Box.

Predefined Margin options available.

All Rights Reserved © Manish Verma (MVS Foundation), for more Notes visit https://www.mvsfoundation.in/ 15
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TOP 5 QUESTIONS

Q-1. What is text formatting?

Answer- Making the text attractive by changing its style, size, color and Alignment is called text

formatting. It includes options such as Font, Size, Bold, Italic etc.
Q-2. What is the use of Format Painter?

Answer- Format Painter is used to copy the formatting of one text and apply it to another text. By this,

the same style can be applied quickly.

Q-3. What is Clipboard?

Answer- Clipboard is a temporary memory where Cut or Copied text is stored and can be pasted later.
Q-4. Tell the difference between Line Spacing and Paragraph Spacing.

Answer- Line Spacing is the distance between two lines, whereas Paragraph Spacing controls the distance

between two paragraphs.
Q-5. Write the process of checking Spelling and Grammar.

Answer- Spelling and Grammar can be checked by pressing F7. For an incorrect word, select the correct

word from the Suggestion Box and click on Change.

All Rights Reserved © Manish Verma (MVS Foundation), for more Notes visit https://www.mvsfoundation.in/ 16
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INTRODUCTION TO INTERNET

Introduction

In this chapter the basic concept of Internet, its uses, types of connections, working process and the study
of e-mail and web browser have been done. Internet is a fast and effective medium of information exchange.

It is extremely useful for education, research and communication.

What Is Internet

¢ Internet is a worldwide network.

e Itis an interconnection of small and large networks.

Applications Of Internet

e Sending messages through e-mail

File Transfer

e Browsing information on the web

e Chatting

e Searching databases

e Reading news

e Sending/receiving animation and pictures
e Creating websites

Getting Internet Connection On Your Compute

e ltis necessary to take connection from Internet Service Provider (ISP)

Monthly/annual charges have to be paid

e Choose connection according to requirement

All Rights Reserved © Manish Verma (MVS Foundation), for more Notes visit https://www.mvsfoundation.in/ 17
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Types Of Internet Connections| Bial up Connection

(a) Dial-up

e Connection through telephone line
e Connect by dialing ISP number

(b) ISDN

e Based on digital phone line

e 128 KBPS speed

e Call and data possible on the same line
(c) Through Leased Lines:

e Permanent connection

e Available 24x7

e Mostly used in institutions

(d) DSL (Digital Subscriber Line)

e High speed broadband connection

e Both internet and call possible through phone line

o Data is divided into small packets (Packets)

e Each packet is attached with a Header

o Packets reach the destination through different routes
e Reassembled again at the destination

e TCP/IP (Transmission Control Protocol/Internet Protocol) performs the work of sending and

checking packets

All Rights Reserved © Manish Verma (MVS Foundation), for more Notes visit https://www.mvsfoundation.in/ 18
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Frequently Used Terms In Internet|

1. WWW (World Wide Web) : Collection of web pages

2. Web Server: The computer in which web pages are stored

3. Hyperlink: A link connecting one page to another page

4. HTML (Hyper Text Markup Language): Language for creating web pages
5. Web Page: Electronic document written in HTML

6. Website: Group of related web pages

7. URL (Uniform Resource Locator): Unique address of a web page

8. IP Address: Numerical address of a computer on the Internet

O

. DNS (Domain Name System): System to convert domain name into IP Address

Understanding Internet Addres

o Domain name gives unique identification

el

hd Exa m ple: WWw.nios.ac.in www — world nios — name ac — academic, in — India,
wide web of the host specity the type country code
computer of organization

e The right part shows organization/country

Organizational Domains

.ac — Academic

e .com — Commercial

e .edu - Educational

¢ .gov - Government

e .net — Network

o .org - Organization
Geographical Domains

e .in—India

All Rights Reserved © Manish Verma (MVS Foundation), for more Notes visit https://www.mvsfoundation.in/ 19
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.au — Australia

Jp —Japan

.uk — United Kingdom

.us — United States

\Web Browse
What is a Browser?

e Software that displays web pages

e Brings information by sending request to server
Popular Browsers:

e Internet Explorer

e Netscape Navigator

o Text File

o Web Page, HTML Only
o Web Page, Complete

e Web Archive (.MHT)

Eiﬂ Yesr Took Hep

Downloading Files| | Haw ¢ ok |
g anie Bt Shotia
Loty 14 st e H il
o Create Temporary Folder :-:’““" _ﬂ -
— I:-I m
. . = 1 s
e Click on download link | B 103 Wama
a] O wiekshane
“' =l H Wi
. W
e Save the file [ ok

A1 (=P Fozweossbbs Dk |00]

e Complete installation

e Delete temporary file
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Internet Services|

Search Engine

YaHoO!
e Program to search information “00 16.
_G gle
o Displays list of results eXcite

altavista

overture @

Google msn®-
Yahoo

MSN Search

Main Search Engines:

Ask Jeeves

Altavista

E-Mail (Electronic Mail)
e Method of sending messages through Internet

e Fast, cheap and available 24x7

Popular Services: ’ EM A\L V
e Yahoo Mail -
e Hotmail

e Gmail

e Rediffmail

1. How does E-mail work?

E-mail is sent from one computer to another through Internet.

Message first reaches Mail Server.

Server sends it to recipient’'s mail server.

When recipient logs-in, message is downloaded.

All Rights Reserved © Manish Verma (MVS Foundation), for more Notes visit https://www.mvsfoundation.in/ 21
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e The whole process completes in a few seconds.

2. Sending and Receiving Messages

Sending Message

e Internet connection is necessary.

e Message is sent through SMTP (Simple Mail Transfer Protocol).
o Message first goes to sender’s mail server.

e From there it is sent to recipient’s mail server.
Receiving Message

e Recipient must have an e-mail account.

e Message is received through POP (Post Office Protocol).
e On logging-in, message appears in inbox.
Components of an E-mail Address

User ID

|
' |
@ symbol . sksharma@yahoo.com |
' - |
|

Host Name (Domain Name)

Top Level Domain (.com, .gov)
Setting up an E-mail Account

A new e-mail account can be created in a few minutes.

Personal information has to be filled.

A User ID and Password have to be chosen.

User ID becomes part of the e-mail address.

User ID can contain letters and numbers, no blank space.
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SMTP

o Simple Mail Transfer Protocol
 Standard protocol for sending e-mail
POP

o Post Office Protocol

e Protocol for receiving e-mail
Sending E-mail

=S

learingcomputer.com ail, baghul - Mozilla Firefox

Flle Edit View History Bookmarks Tools Help
o CIle on compose button - G X & (O htpy/usmg2mailyahoo.com/dd/launchtge=18r T | [$]- best monitorre P |
: ©! (21515 unread) Yahoo! Mail, baghul | + | =
H ini : . HOOLMAIL i, kash + | © ofsiness| psigranon: [Q.searcn |[ websearch |
o Write recipient’s e-mail address in To. Ya! A i Kash + | oo sipraon [Qsea
| CheckmMail || New/|~| | What'sNew | Inbox 222 x ||[<d Testen Hobile | Options + | Help ~
H H H H Qr Search Mail... ‘E ‘}ETQ‘ iATCU i@f Tﬂlﬂgk i‘iﬁré? Select Stationery
e Write subject in Subject. L e S e
£ Drats 7) [ 70| Kkashi com showBCC | | [ I
1 i (=1 sent - L None |
e Write message in Body. S — ——
I Trash Emety | || subject | Testemail Rich Text [ 1 |5
{ | Vote|
e Cc - for carbon copy. Cantacts . —
¥ Folders Add ~ . | |
. 3 Business | just wanted to send you a test email. | Happy Holidays
L] B - f r Iln r n . X realestate 5
cc - for blind carbon copy. o el Kash TS|
[ untitied Eall
e Attach file using Attach Files. |
2 Attach files more easily L SoowfBlosll |
° F|na||y click on Send. S [#] <+ [ here was an error oacing your calendar Retry
Done

Telnet
e Network protocol

e Establishes remote connection with server
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TOP 5 QUESTIONS

Q-1. What is Internet?

Answer- Internet is a worldwide network that connects various small and large networks. It is a fast

medium of exchange of information, messages and data.
Q-2. What is TCP/IP?

Answer- TCP/IP is the main protocol of Internet that sends and checks data in packets. It connects

computers with each other on the Internet.
Q-3. What is URL?

Answer- URL (Uniform Resource Locator) is the unique address of a web page which tells where that page

is located on the Internet.

Q-4. Write the difference between SMTP and POP.

Answer- SMTP is the protocol for sending e-mail, whereas POP is used for receiving e-mail.
Q-5. Tell the difference between Dial-up and Leased Line.

Answer- Dial-up is a temporary connection that connects through phone line. Leased Line is a permanent

24 x7 connection that is mostly used in institutions.
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